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1. What is a spreadsheet program? How does it differ from a word processing program?
      Spreadsheet program is a program consists of cells that organized into columns    and rows, allows users to create their own workbook which can work with data, be used to create tables, graphs, and charts, perform mathematical calculations, manipulate and use the data, and can be saved as webpage to allow users getting access the real-time data in this program. It differs from a word processing because it lays out in rows and columns, can   work with numbers and perform many types of calculations. Otherwise, word processing does not organized in rows and columns, it cannot work with any mathematical calculations.

2. What is the difference between a worksheet and a workbook?

      Worksheet is a single sheet which always stored in a workbook while workbook means that multiple worksheets represented by tabs at the bottom of the Excel screen. The workbook is saved as a file which means the entire workbook is saved when the file is saved.
3. How do you copy and move cell contents?

       In order to copy cell contents, there are 3 steps, which are:

· From the Menu Bar:

- Firstly, click on the selected cell/range of cells which is to be copied.     Then, select the Edit menu, click on Copy command. After that, click on the cell/range of cells you want to paste the cell contents, select the Edit menu again, and lastly click the Paste menu.

· Use the Copy and Paste icons.

· Use the Fill Handle Method.

· Move the mouse pointer over the square in the lower-right corner of the selected cell/cell range. When the mouse pointer changes to a plus block symbol, hold down the left mouse button and drag it to copy.

 To move cell contents, these are the methods:

· From the Menu Bar:

· First, click the selected cell/cell which its contents are to be moved. Select Edit menu, then click on Cut command. Secondly, click where the cell contents are to be moved, then select Edit menu, and click paste command.

· Besides that, we can use the Cut and Paste icons.
4. How do you use the fill handle to copy contents of cells and to create a sequence? What type of sequences can be created using the fill handle?
       In order to use Fill Handle to copy cell contents:

· Notice there is a small black square in the lower-right corner of the cell. Move the mouse pointer on the square, when the pointer changes to plus or black cross, hold down the left mouse button while dragging it down the cell or range of cell where the contents are to be copied.

The methods to create a sequence using the Fill Handle:

· First, we enter the pattern to be replicated.

· Then, right click with the mouse on the small black square (Fill Handle) in the lower-right corner of the cell containing that pattern. Before dragging the mouse down, wait for the mouse pointer to be a small plus block.

· While holding the right mouse button, drag it to select the area to be filled with the matching data.

· Then, open the menu to select “type” of data to be placed in the cells.

To create the sequence using the Fill Handle:

· To automatically fill the cells with the data, we can enter the types of sequence such as:

· Consecutive numbers.

· Numbers in a pattern such as odd or even.

· Days of week, month, years, and dates.

5.     How do you create custom headers and footers?

We firstly start from Menu Bar. Next, we select the View menu. From the menu we select the header and footer command, then the page setup dialog box appear. In the page setup, there are two buttons of the custom header and footer, and then we can create our own header and footer with our own formats. Lastly, we click on the ok command on the header or footer dialog box after finishing about the formats

6. What is a relative cell address reference? How do you change a relative reference to an absolute reference? What is a mixed cell address reference?
Relative cell address referencing is the cell address which automatically changed when the formulas are copied to the new locations. However, we can change a relative reference into an absolute reference. When the cell reference is changed into the absolute reference, it is not adjusted when being copied. These cells must be specifically identified by placing a $ sign before the part that is not to be changed. For example: $B$12 will not be changed when copied to new locations. Besides that, mixed cell address reference is the only row portion or column portion of the cell reference which allows to be adjusted.
7.  What is the formula bar? What is the name box?
Formula bar is: a bar at the top of excel window that we use to enter or edit values or formula in cells or chart, displays the constant value and formulas stored in the active cell. Name box is: small rectangular box which is located at the upper-left corner of the excel window that use to display the active cell reference or can easily find certain cell by typing the cell reference in the name box area.
	Erasing the cell contents
	Deleting the cell contents

	We remove the cell contents (formulas and data), formats (including number formats, conditional formats, and borders), or comments, but you leave the blank cells on the worksheet.
	By clicking Delete on the Edit menu, Microsoft Excel removes them from the worksheet and shifts the surrounding cells to fill the space.


8. What is the difference between erasing the contents of a column and deleting the column?

9. How will you freeze a part of the worksheet?
Freezing a part of the worksheet can be done as follows:

· Select the rows or column to be frozen

· From Menu bar select Window, Freeze Panes.
10. What is the maximum number of significant digits possible in MS Excel?
The maximum number of significant digits in a cell is up to 15 digits.

11. What is the difference between a bar chart and a histogram?
Differences between the bar chart and a histogram:

	Bar chart
	Histogram

	3-Dimensional bar.
	2-Dimensional histogram analysis tool.

	We can change a data series to the cone, cylinder, or pyramid chart type.
	-Can calculate individual and cumulative frequencies for a cell range of data and data bins. It can generate data for the number of occurrences of a value in a data set.


12. How will you put the error bars in the x-y plot? Make a table with data points along with their error values, and draw a graph with errors bars shown.  (hint: See Help facility in Excel)

To put the error bars in the x-y plot, the methods are such stated below:
1. Click the data series to which you want to add error bars.

2. On the Format menu, click Selected Data Series.

3. On the X Error Bars tab or the Y Error Bars tab, select the options you want.
	Measured Values
	Theoretical Values

	Reference points
	POTENTIAL DIFFERENCE (V)
	SIGN (+ or-)
	POTENTIAL DIFFERENCE (V)
	SIGN(+ or -)

	A-B
	0.730
	+
	0.738
	+

	B-C
	7.820
	+
	7.965
	+

	C-D
	9.800
	-
	10.000
	-

	D-A
	1.267
	+
	1.297
	+
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      13.  How will you protect a workbook in MS Excel?
These are the steps to protect a workbook:
· Firstly, go to Tools menu, select the protection command and then select to protect workbook command. Then, a dialog box will appear which is asking us to decide certain password in order to protect the workbook.

14. How to protect only selected cells in MS Excel?
These are the method to protect only the selected cells:
· First go to Tools menu before selecting the command of protection. After that, choose the Protect workbook command. Then, we need to continue the task by inserting certain password. Then, click the selected cell, go to Format menu, select the command cell, followed by protection and lastly click at small box of locked.

15.  Explain the different forms of log functions available in MS Excel

 These are several types of log functions in Excel:
LOG10
This function reacts by returning the logarithm of a number to the base you specify. The correct way ( syntax) to write this type of log function is such this, LOG10(number, base)  Number is the positive real number for which you want the base-10 logarithm. Base   is the base of the logarithm. If base is omitted, it is assumed to be 10. Here are some examples of log10 functions. The example may be easier to understand if you copy it to a blank worksheet.
	
	1


	2


	3


	4


	5



	
	A

B

Formula

Description (Result)

=LOG10(86)

Base-10 logarithm of 86 (1.934498451)

=LOG10(10)

Base-10 logarithm of 10 (1)

=LOG10(1E5)

Base-10 logarithm of 1E5 (5)

=LOG10(10^5)

Base-10 logarithm of 10^5 (5)





IMLOG2

This function is to return the base-2 logarithm of a complex number in x + yi or x + yj text format. If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.
The correct way (Syntax) to write this function is IMLOG2 (inumber).Inumber is a complex number for which you want the base-2 logarithm.
Explanation:
· Use COMPLEX to convert real and imaginary coefficients into a complex number.

· The base-2 logarithm of a complex number can be calculated from the natural logarithm as follows:

· Log2(x + yi)= (Log2 e )ln (x + yi)

This is the example:

	
	1


	2



	
	A

B

Formula

Description (Result)

=IMLOG2("3+4i")

Base-2 logarithm of 3+4i (2.321928 + 1.337804i)





IMLOG10

This function is to return the common logarithm (base 10) of a complex number in x + yi or x + yj text format. If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in. This function is correctly written as IMLOG10 (inumber).Inumber is a complex number for which you want the common logarithm.

Explanation:

· Use COMPLEX to convert real and imaginary coefficients into a complex number.

· The common logarithm of a complex number can be calculated from the natural logarithm as follows:

. This is the example:

	
	1


	2



	
	A

B

Formula

Description (Result)

=IMLOG10("3+4i")

Logarithm (base 10) of 3+4i (0.69897 + 0.402719i)




LOGINV

This function is to return the inverse of the lognormal cumulative distribution function of x, where ln(x) is normally distributed with parameters mean and standard dev. If p = LOGNORMDIST(x,...) then LOGINV(p,...) = x. We use the lognormal distribution to analyze logarithmically transformed data. The correct way to write this function in MS Excel is LOGINV (probability, mean, standard_dev). Probability is a probability associated with the lognormal distribution. Mean is the mean of ln(x).Standard dev. is   the standard deviation of ln(x). 
Explanation:

· If any argument is nonnumeric, LOGINV returns the #VALUE! error value.

· If probability < 0 or probability > 1, LOGINV returns the #NUM! error value.

· If standard_dev <= 0, LOGINV returns the #NUM! error value.

16. In MS Excel, the argument of the sin functions should be in radians.  Assume that you are provided with a set of angles in degrees.  Use radians function in MS Excel to express the angles in radians and then find out the sin of these functions.
· The answer for question 16 is saved as 16 in suwaibah1 Excel File.
17. Use of Help facilities in Excel: Go through the Help facilities in Excel and study several different types of functions.  Explain the application of three different uncommon functions using your own examples. Below are several different types of functions:
DGET
It functions to extract a single value from a column of a list or database that matches conditions you specify. We must write the function of as DGET (database, field, criteria). Database   is the range of cells that makes up the list or database. A database is a list of related data in which rows of related information are records, and columns of data are fields. The first row of the list contains labels for each column. Field indicates which column is used in the function. Field can be given as text with the column label enclosed between double quotation marks, such as "Age" or "Yield," or as a number that represents the position of the column within the list: 1 for the first column, 2 for the second column, and so on. Criteria   are the range of cells that contains the conditions we specify. We can use any range for the criteria argument, as long as it includes at least one column label and at least one cell below the column label for specifying a condition for the column.

This function is useful in managing any big database, lists or information. This application is commonly used by most companies, organizations, and institutions. It can develop a systemic and easy-to-use method of managing and manipulating database. This application is mostly used, for example, to find certain company/companies which are involved in the same field of business. Besides that, this function is useful in doing research which makes the process of finding and accessing to the certain information becomes easier.
CUMIPMT

Its function is to return the cumulative interest paid on a loan between start_period and end_period. If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in. The correct syntax is CUMIPMT (rate, nper, PV, start_period, end_period, type).Rate is the interest rate. Nper is the total number of payment periods.Pv is the present value.Start_period   is the first period in the calculation. Payment periods are numbered beginning with 1.End_period   is the last period in the calculation. Type is the timing of the payment.

This function is closely related to the financial fields. This function is useful in the financial business such as banking, loan institutions, and also can be used by any company in order to arrange their respective business of finance. Commonly, financial fields are too tough and hard to be managed by manual methods, thus we need the help from this function to make our business easier. According to the function of this tool, we can know and take note about the collective interest payment on a loan in a certain period. This will make the calculations of such many numbers become easier and can be done in a rapid manner. In addition, we can easily manipulate and correct any mistakes in writing down the information.
RTD

This function allows the users to retrieve the real-time data from a program that supports COM automation. COM add-in is a supplemental program that extends the capabilities of a Microsoft Office program by adding custom commands and specialized features. COM add-ins can run in one or more Office programs. COM add-ins uses the file name extension .dell or .exe.). The correct way to write this function is =RTD (ProgID, server, topic1, [topic2],...).Pronged is the name of the Pronged of a registered COM automation add-in that has been installed on the local computer. We must enclose the name in quotation marks. Server is the name of the server where the add-in should be run. If there is no server, and the program is run locally, leave the argument blank. Otherwise, enter quotation marks ("") around the server name. When using RTD within Visual Basic for Applications (VBA), double quotation marks or the VBA NullString property are required for the server, even if the server is running locally.topic1, topic2,...  is  1 to 28 parameters that together represent a unique piece of real-time data.

This function is useful in the way of promoting the Microsoft Excel. Other than can perform many types of mathematical calculations, by using this function the users are allowed to retrieve the real-time data from the Excel. Otherwise, this feature can be applied if the program supports COM automation. This feature is useful for the broad spreading of the information and database to the whole of community. This method of transferring, and exchanging the information and the feedback respectively is the best in order to develop the world of information. For example, nowadays is too many challenges around us, thus we need to tightly bound to the information regardless the distance, races, religion, boundaries and many others. This function is able to improve the roles of the Microsoft Excel.
Note: the answers for questions 18-22 is respectively saved as 18,19,20,21 and 22 in Suwaibah1 Excel File.
18. Calculation using Formulas: Select any formula (as complicated as possible) from any one of your textbooks. Use Excel to calculate this formula, by entering the constants and the variables separately.

19. Multiplot: Write down any one formula with two constants (a and b) and one variable (x). (eg. y=a sin (bx) or y=a x + b log (x) …etc).  You can also make up your own formula.  Use Excel to calculate your chosen formula for a range of x values at five different sets of constant values and tabulate them as x vs y with x in the first column and y in the next four columns.
Plot all the four curves in the same plot and label them differently.  Comment on the effect of the constants on these plots.
20. Solving Simultaneous Equations: Write a set of five equations with five variables (eq. p, q, r, s, t and u) and solve them using Excel.  Verify your answer by back substitution.

21. Solver exercise: The following data set is obtained in an experiment: Use the solver module in Excel to fit the data using the equation V=a(1-exp(-b(R-c)))2,
where a, b and c are constants to be determined.  Use solver to determine these constants.  Calculate the V values using the values of a, b and c that you had found out by excel.  Plot the experimental and the calculated data in the same plot and label them properly.  What is the value of V at R=1.25 and R=c?
22. Grades distribution: Consider a class consisting of 12 to 20 students.  Create their mark list in their final exam.   The list should contain their names and their marks in two columns. Use the nested “if condition” to determine their grades (egg. A, B ….) and list them in the third column.  Present their grade distribution as a histogram and as a pie chart.

Note: The answers for Question 23 and 24 are respectively saved as 23 and 24 in Suwaibah1 Excel File.
23.
Computerization of the laboratory report:  Present any of your experimental laboratory report involving detailed calculations and graphs, as an Excel workbook.  Your report should be self-contained and contain all the details to verify your graphs and results.  In short it should look as lab report that you would submit after completing your experiment.

24.
Exercises done in the computer lab: Present a complete report of all the excel exercises done during the lab hours.
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